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ПРЕДУПРЕЖДЕНИЕ 

Когато използвате този продукт, моля, обърнете внимание 

на следното: 

1. Този продукт съдържа много малки части. 

Поглъщането или неправилното използване на някоя 

от тези части може да доведе до сериозни 

медицински усложнения, включително смърт. 

Потърсете незабавно медицинска помощ, ако се 

случи инцидент. 

2. Използването на този продукт и неговите части в 

близост до електрически контакти за променлив ток 

или други вериги е строго забранено поради 

потенциалния риск от токов удар. 

3. Използването на този продукт в близост до течности 

или огън е строго забранено.  

4. Съхранявайте проводящи материали далеч от този 

продукт. 

5. Не позволявайте на малки деца да използват този 

продукт без надзора на възрастни. Този продукт 

трябва да се съхранява на място, недостъпно за 

деца и домашни любимци. 

6. Не съхранявайте и не използвайте този продукт в 

екстремни условия, като например висока или ниска 

температура, висока влажност, пряка слънчева 

светлина и др. 

7. Не забравяйте да прекъсвате веригата, когато тя не 

е необходима. 

8. Някои части на този продукт могат да станат топли 

на допир, когато се използват в определени схеми, 

което е нормално. 

9. Неправилната употреба може да доведе до 

прегряване. 

10. Използването на компоненти, които не са в 

съответствие със спецификацията, може да доведе 

до повреда на продукта. 
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Въведение 

Комплектът SmartHome4SENIORS е създаден на базата на 

микроконтролера Raspberry Pi Pico (RPi Pico). Комплектът е 

създаден в рамките на едноименния проект, съфинансиран 

по програма "Еразъм+", с номер на проекта 2021-1-DE02-

KA220-ADU-000033587. 

Автоматизацията на интелигентни домове е съществуваща 

тенденция, която помага на хиляди хора да опростят 

процесите в домакинствата си. Комплектът 

SmartHome4SENIORS е замислен и разработен с оглед на 

по-ниската степен на готовност на възрастните хора да 

възприемат и разбират технологичните решения за 

интелигентен дом.  

Комплектът има за цел да насърчи безопасния и 

здравословен начин на живот на възрастните хора чрез 

практическо обучение. Комплектът предлага чудесна 

възможност на потребителите да навлязат в света на 

интелигентните решения за домашна автоматизация 

"Направи си сам". 

Комплектът включва целия необходим хардуер 

(микроконтролер, електроника, сензори, периферни 

устройства и т.н.), включващ концепции за физически 

изчисления и програмиране.  

Обхватът на настоящото ръководство е:  

• Информирайте се за компонентите на комплекта и 

използването на основните електронни елементи.  

• Напътства ви стъпка по стъпка за ефективно 

сглобяване на комплекта, като взема предвид 

съответните предпазни мерки.  

• Предоставяне на уроци за използване на 

компонентите и свързването им с микроконтролера 

RPi Pico.   
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• Предоставяне на учебни материали с 

функционалността и обхвата на всеки електронен 

компонент. 

 

Наслаждавайте се на четенето и се 

забавлявайте чрез практически упражнения и 

експерименти с комплекта 

SmartHome4SENIORS 

Съдържание 

Въведение ................................................................................ 1 

Съдържание ............................................................................. 2 

Включен в комплекта SmartHome4SENIORS ........................ 4 

Обяснение на компонентите ................................................... 6 

1. Какво представлява макетната платка? ................... 6 

2. Какво представлява резисторът? .............................. 7 

3. Какво представлява кондензаторът? ...................... 11 
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5. Какво представлява джъмпер кабелът? ................. 12 
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7. Двигател за постоянен ток (малък вентилатор) ..... 59 
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9. OLED I2C SSD1306 дисплей .................................... 65 

10. RFID четец RC522 ..................................................... 70 
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Включен в комплекта 
SmartHome4SENIORS 

  

  

 

1 x Микроконтролер 
Raspberry Pi Pico 

 
 

 

1 x модул за 
захранване MB-102 

 

 

1 x Бяла платка за хляб 
830 бр. 

 

 

1 x бутон за натискане 
&  

1 x капачка за бутон 
 

 

1 x зумер 
 

 

5 x резистори 220 Ohm 
& 

2 x 1k Ohm 
 
 

 
 
 

1 x LDR фоторезистор 
 
 

 

 1 x 100uF кондензатор  
 

 

4 x LED 3 мм 
(синьо, зелено, 

червено, жълто) 
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1 x RGB LED 

 

 

1 x светодиоден модул 
на светофара 

 
 

 
 
 

1 x вентилатор (DC 
мотор) 

 

 

1 x модул за 
управление TIP-120 

 

 

1 x диод 1N4007 
 
 

 
 

1 x сервомотор SG90 
 

 

1 x OLED SSD1306 I2C 
дисплей 

 

 

1 x Ултразвуков сензор 
HC-SR04 

 
 

 
 
 

1 x PIR сензор за 
движение HC-SR501 

 

 
 

1 x Цифров сензор за 
температура и 

влажност DHT11 
 

 

1 x Сензор за качество 
на въздуха MQ-135 

 

 

1 x сензор за откриване 
на пламък 

 
 

 
 

1 x Сензор за 
дъждовни капки 

 

 

1 x RFID четец RC522 
 

 

1 x RFID етикет 3.56MHz 
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Обяснение на компонентите 

1. Какво представлява макетната платка? 

 

Платката за хляб е пластмасова платка с малки отвори, 

които позволяват лесното поставяне на електронни 

компоненти (транзистори, резистори, чипове и др.) за 

създаване на прототип (изграждане и тестване) на 

електронна схема. Вътрешността е съставена от редици от 

1 x Ротационен 
потенциометър Linear 

B1k Ohm 
 

 
 

1 x кабел от USB към 
micro-USB 

 

 
 

6 x AA 1,5V батерии и 1 
x държач за батерии 

 

 

9 x джъмперни кабела 

 

19 x метални болтове 2 
мм и 19 x метални 

гайки 2 мм 
 

 

4 x винтове за метал 2 
мм 
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малки метални щипки, които държат кабелите, които трябва 

да бъдат свързани.  

На повечето платки са изписани редове с цифри, букви и 

знаци плюс и минус. Целта на етикетите е да ви помогнат да 

откриете определени отвори на платката, за да можете да 

следвате указанията при изграждането на схема. 

Дългите ленти от двете страни на платката обикновено се 

маркират с червено и синьо или червено и черно и съответно 

със знаци плюс (+) и минус (-). Тези редове се наричат шини 

или релси и обикновено се използват за подаване на 

електрическо захранване към схемата, когато е свързана 

към захранващ блок (батерия или външно захранване).  

Положителната "шина" е маркирана в червено, има знак 

плюс (+) и осигурява захранването.  

Отрицателната "шина" е маркирана в синьо или черно, има 

знак минус (-) и осигурява заземяването.  

Предимства на използването на платка: 

• Улеснява бързата проверка на прости и сложни 

вериги, както и лесната проверка на вериги в 

началния им етап. 

• Лесно регулиране. 

• Гъвкавост. 

• Без пробиване на отвори. 

• Не се изисква запояване. 

• Лесно отстраняване на грешки в схемите и 

програмите. 

2. Какво представлява резисторът? 
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Резисторът е малък пакет от съпротивления. Използването 

му в дадена верига намалява тока с точно определено 

количество. Съпротивлението на резистора се определя по 

модел от цветни ленти.   

 

(Кредит за изображение: Future Owns) на разположение на 

https://www.tomshardware.com/how-to/resistor-color-codes 

  

https://www.tomshardware.com/how-to/resistor-color-codes
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Обичайни цветови кодове на резисторите и тяхното 

използване: 

Тип на 
резистора 

4-лентов 
цветови код  

5-лентов 
цветови код 

Общи 
употреби 

220Ohm Червено-
червено-
кафяво-
златно 

Червено-
червено-
черен-черен-
златен 

Защита на 
LED 
светлината 

1K Ohm 
(1Kiloohm) 

Кафяво-
черно-
червено-
златно 

Кафяво-
черно-черно-
кафяво-
златно 

Защита на 
LED, делител 
на 
напрежение 

Резисторите нямат полярност, така че могат да се използват 

във всякаква ориентация във веригата. Но за да определим 

правилните стойности на цветовите кодове на резисторите, 

трябва да разберем цветните ленти върху резистора. 

При типичен четирилентов хоби резистор за ниво има три 

цвята в група. Това са първата, втората значеща цифра и 

множителят. Последната група е толерансът на резистора, 

границата на грешка, ако щете. За повечето любители 

толерансът от 5 % (злато) е идеален и обичаен. 

Резистор 220 ома (4-лентов)  
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(Кредит за изображение: Future) на разположение на 

https://www.tomshardware.com/how-to/resistor-color-codes  

1. Първата значеща цифра е червена и с помощта на 

дешифратора виждаме, че червеното има стойност 

2. 

2. Втората значеща цифра също е червена, така че 

получаваме 22. 

3. Множителят е кафяв и се дешифрира до 10. Ако 

умножим 22 по 10, ще получим 220. 

4. Последната лента - толерантност - е златна. Златото 

е 5%, което означава, че можем да приемем 

съпротивление с 5% допустима грешка. 

За производителите, които се нуждаят от по-голяма 

прецизност, се предлагат и петлентови резистори с трета 

значеща цифра. Допълнителната цифра осигурява яснота, 

която може да бъде от съществено значение във вериги, 

чувствителни към съпротивлението, например научни и 

инженерни инструменти. 

Резистор 1K Ohm (4-лентов) 
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(Кредит за изображение: Tom's Hardware) на разположение на 

https://www.tomshardware.com/how-to/resistor-color-codes  

1. Линията 1st е кафява и с помощта на декодера можем 

да видим, че стойността е 1. 

2. Линията 2nd е черна, така че получаваме 10. 

3. Множителят е червен и се дешифрира до 100. Ако 

умножим 10 по 100, ще получим 1000. 

4. Последната лента - толерантност - е златна. Златото 

е 5%, което означава, че можем да приемем 

съпротивление с 5% допустима грешка. 

3. Какво представлява кондензаторът? 

 

Кондензаторът е устройство, което съхранява електрическа 

енергия в електрическо поле. Той е пасивен електронен 

компонент с два терминала. Състои се от два електрически 
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проводника, които са разделени на определено разстояние. 

Пространството между проводниците може да бъде 

запълнено с вакуум или с изолационен материал, известен 

като диелектрик. (Уикипедия) 

Кондензаторът 100uF е електролитен разединителен 

кондензатор. Тези кондензатори са чудесни потискатели на 

преходни процеси/напрежения и използването на такъв 

между захранването и земята на веригата гарантира 

безпроблемно подаване на енергия. 

4. Какво представлява диодът? 

 

Диодът е електронен компонент с два терминала, който 

провежда ток предимно в една посока (асиметрична 

проводимост); той има ниско (в идеалния случай нулево) 

съпротивление в едната посока и високо (в идеалния случай 

безкрайно) съпротивление в другата. 

Най-често срещаната функция на диода е да позволява 

преминаването на електрически ток в една посока (наречена 

директна посока на диода), като същевременно го блокира в 

противоположната посока (обратна посока). По този начин 

диодът може да се разглежда като електронна версия на 

възвратен клапан. Това еднопосочно поведение се нарича 

изправяне и се използва за преобразуване на променлив ток 

(AC) в постоянен ток (DC). В качеството си на 

токоизправители диодите могат да се използват за такива 

задачи като извличане на модулация от радиосигнали в 

радиоприемници. (Уикипедия 

https://en.wikipedia.org/wiki/Diode)  

5. Какво представлява джъмпер кабелът? 

 

https://en.wikipedia.org/wiki/Diode
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Кабелите за джъмпер са просто проводници, които имат 

щифтове за свързване във всеки край, което позволява да 

се използват за свързване на две точки една към друга без 

запояване. Обикновено джъмперните кабели се използват с 

дъски и други инструменти за прототипиране, за да се 

улесни промяната на схемата при необходимост. Цветовите 

вариации на проводниците могат да се използват като 

предимство за разграничаване на видовете връзки, като 

например заземяване или захранване. 

Прекъсвачите обикновено се предлагат в три варианта: 

мъжки към мъжки, мъжки към женски и женски към женски. 

Разликата между тях е в крайната точка на проводника. 

Мъжките краища имат изпъкнал щифт и могат да се 

включват в различни неща, докато женските краища нямат 

такъв щифт и се използват за включване в различни неща. 

Най-често срещаните проводници са мъжки-мъжки. Когато 

свързвате два порта на платка, най-често се изисква мъжки 

проводник. (https://blog.sparkfuneducation.com/what-is-

jumper-wire)  

https://blog.sparkfuneducation.com/what-is-jumper-wire
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Подготовка на проекта 

1. Readme Преди употреба 

ЗАБЕЛЕЖКА: Тъй като всички експерименти са свързани с 

електрически вериги, неправилно свързване или късо 

съединение може да повреди вашата развойна платка RPi 

Pico. Моля, винаги проверявайте веригата отново, преди да 

свържете захранването. 

2. Микроконтролер Raspberry Pi Pico 

Това е Raspberry Pi Pico: 

 

Включете кабела micro-USB в порта от лявата страна на 

платката. 
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3. Инсталиране на Thonny IDE 

Посетете https://thonny.org и изберете подходящата 

операционна система. Следвайте инструкциите, за да 

завършите инсталацията. 

 

В това ръководство всички уроци са програмирани в 

Windows 10, като се използва микроконтролер RPi Pico и 

подходящ фърмуер. 

След като инсталацията приключи, отворете Thonny от 

компютъра.  

 

https://thonny.org/
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4. Инсталиране на фърмуера 

RPi Pico може да се програмира с помощта на вариант на 

Python, наречен MicroPython. За да използвате MicroPython 

на RPi Pico, първо трябва да инсталирате неговия фърмуер.  

Стъпка 1: Намерете бутона BOOTSEL на вашия Raspberry Pi 

Pico. 

 

Стъпка 2: Натиснете бутона BOOTSEL и го задръжте, докато 

свързвате другия край на micro-USB кабела към компютъра. 

Стъпка 3: В долния десен ъгъл на Thonny ще видите 

версията на Python, която използвате в момента.  

 

Кликнете върху версията на Python и изберете MicroPython 

(Raspberry Pi Pico) 
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Ако не виждате тази опция, уверете се, че кабелът е свързан 

правилно в Pico и/или в компютъра ви. 

Стъпка 4: Ще се появи диалогов прозорец, в който ще бъдете 

помолени да инсталирате най-новата версия на фърмуера 

на вашия Pico. Щракнете върху бутона Инсталиране, за да 

копирате фърмуера на вашия Pico. 

 

Стъпка 5: Изчакайте инсталацията да приключи и щракнете 

върху Затвори. 
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Не е необходимо да повтаряте процеса всеки път, когато 

свързвате Raspberry Pi Pico към компютъра си, така че 

следващия път просто го включете и сте готови за работа. 

5. Въведение в програмирането на MicroPython 

Сега ще използвате Thonny IDE, за да стартирате няколко 

прости кода на Python, за да се запознаете с Thonny's Shell и 

MicroPython. 

Първо се уверете, че вашият Raspberry Pi Pico е свързан към 

компютъра и сте избрали интерпретатора MicroPython, както 

е обяснено в предишния раздел. 

Панелът Shell в долната част на редактора на Thonny трябва 

да изглежда по следния начин: 

 

Thonny е готов да комуникира с вашия Pico с помощта на 

REPL (read-eval-print loop) рамка, която ви позволява да 

пишете код директно в Shell и да получавате резултати. 
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Въведете следната команда: 

печат("Здравейте!") 

След това натиснете клавиша Enter и вижте следния изход: 

 

MicroPython ви позволява да добавяте специфични за 

хардуера модули, като например machine, които можете 

да използвате за програмиране на вашия Pico. В следващия 

пример ще използвате модула machine, за да включите 

вградения светодиод на Pico. 

Напишете следния код в Thonny's Shell: 

от machine внос Pin 

led = Pin(25, Pin.OUT) 

led.value(1) 

 

Натиснете клавиша Enter и вграденият светодиод на Pico 

веднага ще се включи. 
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За да изключите светодиода, напишете следния код: 

led.value(0) 

  

В останалата част на този раздел ще напишете първата си 

"истинска" програма, която ще накара вградения светодиод 

да мига всеки път, когато стартирате програмата си. 

Thonny Shell е полезен за изпробване на бързи команди и за 

да се уверите, че всичко работи правилно. По-дългите 

програми обаче трябва да се записват в .py файл. С 

помощта на Thonny можете да записвате програми директно 

на Raspberry Pi Pico и след това да ги стартирате. 

Отворете Thonny Python и в главния панел на редактора 

напишете следния код: 

от machine внос Pin 

led = Pin(25, Pin.OUT) 

led.toggle() 

Сега запазете програмата си, като щракнете върху иконата 

Save (Запазване) в горния ляв ъгъл или като натиснете 

Ctrl+S на клавиатурата. 
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Thonny ще ви попита къде искате да бъде запазена вашата 

програма. Изберете Raspberry Pi Pico. Запишете файла 

като blink.py и щракнете върху OK. Винаги трябва да 

добавяте разширението .py, за да може Thonny да разпознае 

файла като Python файл. 

 

Сега всеки път, когато щракнете върху иконата Play, трябва 

да виждате как вграденият светодиод се включва и 

изключва. 

Ако направите още една стъпка напред, можете да накарате 

вградения светодиод да мига с определена скорост. 



 
2021-1-DE02-KA220-ADU-000033587 

 

 
 

23 w: sh4seniors.erasmusplus.website 

e: info@sh4seniors.erasmusplus.website 

Напишете следния код и запазете програмата си, като 

използвате същото име, както по-горе. 

от machine внос Pin 

от time внос sleep 

led = Pin(25, Pin.OUT) 

докато е вярно: 

 led.toggle() 

 заспиване (1) 

Сега, когато стартирате програмата, вграденият светодиод 

ще мига на всеки 1 секунда, докато не спрем програмата. За 

да спрете програмата, можете да щракнете върху иконата 

STOP или да натиснете Ctrl+C на клавиатурата. 

В следващите уроци ще научим как да добавяме и 

управляваме друга електроника и сензори и да създаваме 

програми, които могат да комуникират помежду си. 
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Сглобяване на комплекта SmartHome 

Процесът на сглобяване изисква следните елементи: 

• 6 x парчета шперплат 

• 10 x метални болтове 

• 10 x метални гайки 

 

Процедурата е проста и се извършва в 7 стъпки. Всички 

парчета шперплат се маркират в десния страничен ъгъл със 

следното обозначение: 

BP: Базова част 

B: Част от задната страна 

F: Предна част 

L: лява част 

R: Дясна част  
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Стъпка 1: Поставете основата от шперплат върху 

хоризонтална повърхност. 

 

Стъпка 2: Поставете парчето от задната страна, както е 

показано на изображението. 
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Стъпка 3: Поставете парчето от предната страна, както е 

показано на изображението. 
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Стъпка 4: Поставете лявата част на шперплата, както е 

показано на изображението.  
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Стъпка 5: Поставете дясната страна на шперплата, както е 

показано на изображението. 

 

  



 
2021-1-DE02-KA220-ADU-000033587 

               

 
 

30 

Стъпка 6: Затегнете парчетата шперплат, като използвате 

10 болта и 10 гайки.  

• 6 болта и гайки са поставени под основната част и 

отговарят за сглобяването на стените. 

• На стените от лявата и дясната страна са поставени 

4 болта и гайки, които поддържат стабилността на 

конструкцията. 
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Стъпка 7: Поставете покрива от шперплат върху модела на 

къщата, както е показано на изображението: 
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Монтаж на електрониката на комплекта 
SmartHome 

В модела на къщата SmartHome трябва да се монтират 

няколко електронни устройства. На следващите 

изображения е представено подробно каква електроника да 

се монтира и как да се монтира на различните слотове. Ще 

ви трябват също така отвертка с глава "Филипс" и клещи. 

 

Поставете Raspberry Pi Pico върху платката, заедно със 

захранващия модул (MB-102) и бутона. Под дъската за хляб 

има залепваща повърхност, затова не забравяйте да 

Сензор за 

пламък  

Сензор за 

качество на 

въздуха 

Температурен 

сензор 

Breadboard 830pcs 

Raspberry 

Pi Pico Бутон за 

натискане 

MB-102 

Захранващ 

модул 
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отлепите защитния слой и след това да я поставите върху 

основната част на къщата.  

Има някои електронни устройства, които трябва да се 

монтират на задната стена. Това са сензорът за пламък, 

сензорът за качество на въздуха и сензорът за температура 

и влажност DHT11. Необходимо е да използвате следните 

елементи: 

• Сензор за пламък: 1 x болт и 1 x гайка. Монтирайте 

го през средната част на сензора и се уверете, че 

сензорът (черната част) гледа нагоре. 

• Сензор за качество на въздуха: 2 x болт и 2 x гайка. 

Монтирайте го през горния ляв и горния десен 

монтажен отвор. 

• DHT11: 2 x болт и 2 x гайка. Трябва да огънете 

сензора (синята част) напред, за да получите достъп 

до монтажните отвори. След това монтирайте 

сензора през горния ляв и горния десен монтажен 

отвор. 

Върху лявата част ще трябва да монтирате вентилатор за 

постоянен ток и светодиодна лампа. За вентилатора за 

постоянен ток ще използвате болтовете и гайките, които са 

включени в комплекта (4 x болтове и 4 x гайки). Поставете 

светодиода в монтажния отвор и триенето ще го задържи 

на място.  
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Върху дясната част ще трябва да монтирате 5V зумер, 

потенциометър и светодиод. 

Поставете зумера в горния десен ъгъл (уверете се, че 

щифтовете му са от вътрешната страна на модела на 

къщата) и триенето ще го задържи на място.  

Потенциометърът вече има монтиран пръстен с гайка, 

който трябва да отвиете. Поставете потенциометъра от 

вътрешната страна на къщата към външната, така че лостът 

да изглежда както на изображението по-долу. След това 

завийте обратно пръстена на гайката, докато се затегне 

достатъчно, за да се задържи на място, когато завъртите 

лоста.  

Накрая трябва да се инсталира светодиод. Поставете 

светодиода в монтажния отвор и триенето ще го задържи на 

място. 

Вентил

атор за 

постоя

нен ток 

LED 
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В предната част на модела на къщата трябва да се монтират 

няколко сензора и електроника.  

• Сервомотори: 4 x винтове. Поставете ги от 

вътрешната страна на къщата към външната и ги 

монтирайте с помощта на винтовете, включени в 

опаковката. 

• PIR Сензор за движение: 2 x болт и 2 x гайка. 

Монтирайте го през горния ляв и долния десен 

монтажен отвор. 

• Сензор RFID: 2 x болт и 2 x гайка. Монтирайте го 

през горния ляв и долния десен монтажен отвор. 

• OLED дисплей: 2 x болт и 2 x гайка. Монтирайте го 

през горния ляв и долния десен монтажен отвор. 

• Модул за светофари: 2 x болт и 2 x гайка. Поставете 

модула от вътрешната страна на къщата към 

външната. След това го монтирайте през двата 

монтажни отвора от дясната страна. 

• Ултразвуков сензор: Поставете го от вътрешната 

страна на къщата към външната. Триенето ще го 

задържи на мястото му. 

• LED: Поставете светодиода в монтажния отвор и 

триенето ще го задържи на място. 



 
2021-1-DE02-KA220-ADU-000033587 

 

 
 

37 w: sh4seniors.erasmusplus.website 

e: info@sh4seniors.erasmusplus.website 

 

  

Сервомото

р 

Сервомото

р 

Ултразвуко

в сензор 

Модул за 

светофари 
PIR сензор 

за 

движение

 

Сензо

р 

RFID 

LED 

OLED 



 
2021-1-DE02-KA220-ADU-000033587 

               

 
 

38 

Накрая на покрива трябва да се монтира сензорът за 

дъждовни капки. Използвайте 2 х болта и 2 х гайки и го 

монтирайте през монтажните отвори в горния ляв и долния 

десен ъгъл. 

 

След като всички електронни устройства и сензори са 

монтирани на място, трябва да ги свържете с помощта на 

кабелите за джъмпери, които са включени в пакета. Тази 

процедура обаче ще бъде обяснена в раздела с уроци, 

където ще бъдат обяснени различните GPIO изводи на 

Raspberry Pi Pico и изводите на всеки електронен компонент 

или сензор. 

В опаковката ще намерите и 6 батерии АА и държач за 

батерии. Поставете батериите върху държача за батерии и 

засега го дръжте настрана. В по-късен урок ще научите къде 

трябва да го поставите и как трябва да бъде свързан със 

захранващия модул MB-102.   

Сензор 

за 

дъждовн

и капки 
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Основни уроци 

0. "Здравейте, хора от SmartHome!" 

В този основен урок ще научим как да отпечатаме просто 

съобщение в Thonny с помощта на програмиране в Python. 

Функцията print() 

1. Отидете в редактора на Thonny, напишете следния 

код и натиснете иконата за възпроизвеждане. Thonny 

ще ви помоли първо да запазите програмата си. 

Запишете я под името hello.py. 

 

2. Проверете прозореца на обвивката. 

 

3. Добра работа! Току-що създадохте първата си 

програма на Python. 
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Функцията print е вградена функция на Python, която ни 

позволява да отпечатваме текст в обвивката. Тя може да 

приема и параметри. Създайте нова програма и копирайте 

следния код, след което натиснете Play и вижте как се 

появява текстът в шела. 

 

Както можете да видите в прозореца на обвивката, всяка 

функция за печат отпечатва текст на отделен ред. Въпреки 

това, ако използвате "\n" (символ за нов ред), можете да 

смените реда в същата команда за печат. 

 

Упражнение 

Използвайте функцията print, за да отпечатате в 3 отделни 

реда "Goodbye SmartHome people!", като използвате само 

един оператор print. 
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1. Управление на светодиод 

Описание 

В този урок ще научите как да свържете и управлявате 

светодиодна лампа. Отворете Thonny Python, след това 

отидете на File→ Save as..., изберете Raspberry Pi Pico и 

запишете файла си под името led.py. След това е време 

да свържете електрониката и да напишете програмата си. 

Моля, следвайте инструкциите по-долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 2 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка  • 1 x LED (произволен цвят) 

• 1 x Micro-USB кабел  • 1 x 220 Ohm резистор 

 

Схема на свързване 

 

- свържете по-дългия край (+) на светодиода с резистор 220 

Om 

- свържете резистора към GPIO5 (червен кабел) 

- свържете по-късия край (-) на светодиода към извод GND.  
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Код 

Код на MicroPython за урока: 

 

Образци на изображения 

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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2. Бутон за натискане 

Описание 

В този урок ще научите как да свържете и управлявате бутон. 

Отворете Thonny Python, след това отидете на File→ Save 

as..., изберете Raspberry Pi Pico и запишете файла си под 

името button.py. След това е време да свържете 

електрониката и да напишете програмата си. Моля, 

следвайте инструкциите по-долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 3 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x 220 Ohm резистор 

• 1 x Micro-USB кабел • 1 x капачка за бутон 

• 1 x бутон за натискане 
(произволен цвят) 

 

 

Схема на свързване 

 

- свържете горната лява страна на бутона към щифта 3v3 

(червен кабел) 

- свържете долния десен бутон към GPIO5 (жълт кабел) 
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- свържете щифт GND към шината (-) (черен кабел). 

- свържете резистора 220 Om към (-) релсата и долната 

дясна страна на бутона  
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Код 

Код на MicroPython за урока: 

 

Образци на изображения 

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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3. Звуков сигнал 

Описание 

В този урок ще научите как да свържете и управлявате 

зумер. Отворете Thonny Python, след това отидете на File→ 

Save as..., изберете Raspberry Pi Pico и запишете файла си 

под името buzzer.py. След това е време да свържете 

електрониката и да напишете програмата си. Моля, 

следвайте инструкциите по-долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 2 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x зумер 

• 1 x Micro-USB кабел  

 

Схема на свързване 

 

- свържете по-дългия край (+) на зумера към щифта GPIO5 

- свържете по-късия край (-) на зумера към извод GND.  
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Код 

Код на MicroPython за урока: 

 

Образци на изображения 

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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4. Потенциометър 

Описание 

В този урок ще научите как да свържете и управлявате 

потенциометър. Отворете Thonny Python, след това отидете 

на File→ Save as..., изберете Raspberry Pi Pico и запишете 

файла си под името pot.py. След това е време да свържете 

електрониката и да напишете програмата си. Моля, 

следвайте инструкциите по-долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 3 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x потенциометър 

• 1 x Micro-USB кабел  

 

Схема на свързване 

 

- черният кабел трябва да бъде свързан към GND (Pin 3). 

- жълтият кабел трябва да бъде свързан към GPIO26 ADC 

pin 
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- червеният кабел трябва да бъде свързан към пина за 

захранване 3V3 

- завъртете потенциометъра наляво, така че да е изключен 

Код 

Код на MicroPython за урока: 

 

Образци на изображения 

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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Уроци за напреднали 

Преди да преминем към този и следващия раздел, трябва да 

направим няколко промени в нашата развойна платка. Това 

включва добавянето на няколко допълнителни компонента и 

тяхната свързаност. 

Компоненти 

• 1 x комплект батерии 6-AA • 1 x захранващ модул MB-102 

• 4 x мъжки-мъжки джъмперни 
проводници 

 

Моля, следвайте схемата за свързване на новите 

компоненти: 

 

- Тази настройка ще се използва за останалите уроци. 

- връзки от горната страна: VSYS 5V ((+) червено) и GND ((-) 

черно) 

- долни странични връзки: 3V3 ((+) червено) и GND ((-) черно) 

Образци на изображения 



 
2021-1-DE02-KA220-ADU-000033587 

 

 
 

53 w: sh4seniors.erasmusplus.website 

e: info@sh4seniors.erasmusplus.website 

 

5. LED светлини за движение модул 

Описание 

В този урок ще научите как да свържете и управлявате 

модула за светодиодни светофари. Отворете Thonny Python, 

след това отидете на File→ Save as..., изберете Raspberry Pi 

Pico и запишете файла под името traffic.py. След това е 

време да свържете електрониката и да напишете 

програмата си. Моля, следвайте инструкциите по-долу. 

Необходими материали 

• 1 x Raspberry Pi Pico • 4 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x модул за светодиодни 
светлини 

• 1 x Micro-USB кабел  

Схема на свързване 
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- оранжевият кабел (R) е свързан към щифта GPIO3 

- жълтият кабел (Y) е свързан към щифта GPIO4 

- зеленият кабел (G) е свързан към щифта GPIO5 

- черният кабел (GND) е свързан към GND шината ((-) черно) 
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Код 

Код на MicroPython за урока: 

 

Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 



 
2021-1-DE02-KA220-ADU-000033587 

               

 
 

56 

 

6. Фоторезистор LDR 

Описание 

В този урок ще научите как да свържете и управлявате LDR 

фоторезистор. Отворете Thonny Python, след това отидете 

на File→ Save as..., изберете Raspberry Pi Pico и запишете 

файла под името ldr.py. След това е време да свържете 

електрониката и да напишете програмата си. Моля, 

следвайте инструкциите по-долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 3 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x LDR фоторезистор 

• 1 x Micro-USB кабел • 1 x 220Ohm резистор 

 

Схема на свързване 
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- лявата страна на LDR е свързана към 3V шина ((+) червено) 

- дясната страна на LDR е свързана с резистор 220 ома и с 

GPIO26 ADC (жълт кабел). 

- дясната страна на резистора е свързана към GND шината 

((-) черно)  
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Код 

Код на MicroPython за урока: 

 

Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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7. Двигател за постоянен ток (малък 
вентилатор) 

Описание 

В този урок ще научите как да свържете и управлявате малък 

постояннотоков (DC) двигател. Отворете Thonny Python, 

след това отидете на File→ Save as... (Файл Запази като...), 

изберете Raspberry Pi Pico и запазете файла си под името 

fan.py. След това е време да свържете електрониката и да 

напишете програмата си. Моля, следвайте инструкциите по-

долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 3 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x DC мотор (малък 
вентилатор) 

• 1 x Micro-USB кабел • 1 x транзистор TIP-120 

• 1 x диод  

 

Схема на свързване 
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Код 

Код на MicroPython за урока: 
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Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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8. Сервомотор SG-90 

Описание 

В този урок ще научите как да свържете и управлявате 

сервомотор. Отворете Thonny Python, след това отидете на 

File→ Save as..., изберете Raspberry Pi Pico и запишете 

файла си под името servo.py. След това е време да 

свържете електрониката и да напишете програмата си. 

Моля, следвайте инструкциите по-долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 3 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x сервомотор SG-90 

• 1 x Micro-USB кабел  

 

Схема на свързване 

 

- червеният кабел е свързан към шината 5V (+) 

- черният/кафявият кабел е свързан към шината GND (-) 
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- оранжевият кабел е свързан към GPIO28 ADC pin 
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Код 

Код на MicroPython за урока: 

 

Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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9. OLED I2C SSD1306 дисплей 

Описание 

В този урок ще научите как да свържете и управлявате I2C 

ICC OLED дисплея. Отворете Thonny Python, след това 

отидете на File→ Save as..., изберете Raspberry Pi Pico и 

запазете файла под името oled.py. След това е време да 

свържете електрониката и да напишете програмата си. 

Моля, следвайте инструкциите по-долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 4 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x OLED I2C SSD1306 
дисплей 

• 1 x Micro-USB кабел  

 

Схема на свързване 
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- червеният кабел е свързан към шината 3v3 (+) 

- черният кабел е свързан към шината GND (-) 

- оранжевият кабел е свързан към GPIO17 I2C0 SCL pin 

- синият кабел е свързан към GPIO26 I2C0 SDA pin 

 

Код 

Преди да започнем програмирането на OLED дисплея, 

първо трябва да добавим пакета SSD1306 към нашия RPi 

Pico. За да направите това, моля, следвайте следващите 

стъпки: 

1. Отворете Thonny и отидете на Tools→ Manage 

packages... 
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2. В прозореца за управление на пакети въведете 

SSD1306 и щракнете върху Търсене. 

 

3. След като търсенето приключи, кликнете върху 

micropython-ssd1306. 
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4. В следващия прозорец щракнете върху 

Инсталиране. 

 

5. Изчакайте инсталирането на пакета, след което 

щракнете върху Затвори. 

Сега сме готови да пристъпим към програмиране на OLED 

дисплея.  
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Код на MicroPython за урока: 

 

Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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10. RFID четец RC522 

Описание 

В този урок ще научите как да свържете и управлявате модул 

за четене на RFID. Отворете Thonny Python, след това 

отидете на File→ Save as..., изберете Raspberry Pi Pico и 

запишете файла под името rfid.py. След това е време да 

свържете електрониката и да напишете програмата си. 

Моля, следвайте инструкциите по-долу. 

 

Необходими материали 

• 1 x Raspberry Pi Pico • 7 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x RFID модул RC522 

• 1 x Micro-USB кабел • 1 x RFID етикет 

 

Схема на свързване 

 

- 3v3 (червен кабел) е свързан към шината 3v3 (+) 

- GND (черен кабел) е свързан към GND шина (-) 

- RST (жълт кабел) е свързан към щифт GPIO0 

- SDA (белият кабел) е свързан към щифта GPIO1 
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- SCK (зеленият кабел) е свързан към щифта GPIO2 

- MOSI (син кабел) е свързан към щифт GPIO3 

- MISO (оранжев кабел) е свързан към щифт GPIO4 

Код 

Подобно на OLED дисплея, имаме нужда от допълнителна 

библиотека, която да управлява RFID модула, а именно 

библиотеката MFRC522. Можем да я изтеглим от 

https://github.com/pimylifeup/MFRC522-

python/blob/master/mfrc522/MFRC522.py. Изтеглете файла и 

го отворете в Thonny Python. След това щракнете върху File 

(Файл)→ Save as... (Запази като...), изберете Raspberry Pi 

Pico и запазете файла под името mfrc522.py.  

След това трябва да идентифицирате идентификатора на 

флашката, за да може RFID четецът да работи. За да 

направите това, трябва да създадете програма, която да 

чете RFID Fob и да дава неговия идентификатор. Вижте 

програмата по-долу: 
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Кликнете върху Възпроизвеждане и сканирайте флашката. 

Това ще ви даде неговия идентификатор. Сега, обратно към 

програмата rfid.py, трябва да промените числото в ред 

20, така че да съвпада с идентификатора на вашия fob. След 

това щракнете върху Save (Запази) и стартирайте 

програмата си.Код на MicroPython за урока: 
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Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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Уроци със сензори 

11. Сензор за дъждовни капки 

Описание 

В този урок ще научите как да свържете и управлявате 

сензора за дъждовни капки. Отворете Thonny Python, след 

това отидете на File→ Save as..., изберете Raspberry Pi Pico 

и запишете файла под името raindrop.py. След това е 

време да свържете електрониката и да напишете 

програмата си. Моля, следвайте инструкциите по-долу. 

Необходими материали 

• 1 x Raspberry Pi Pico • 3 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x Сензор за дъждовни капки 

• 1 x Micro-USB кабел  

Схема на свързване 

 

- 3v3V (червен кабел) е свързан към шината 3v3V (+) 

- GND (черен кабел) е свързан към GND шина (-) 
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- DO (оранжев кабел) е свързан към щифт GPIO17 

Код 

Код на MicroPython за урока: 

 

Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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12. Ултразвуков сензор HC-SR04 

Описание 

В този урок ще научите как да свържете и управлявате 

ултразвуковия сензор HC-SR04. Отворете Thonny Python, 

след това отидете на File→ Save as..., изберете Raspberry Pi 

Pico и запишете файла под името ultrasonic.py. След 

това е време да свържете електрониката и да напишете 

програмата си. Моля, следвайте инструкциите по-долу. 

Необходими материали 

• 1 x Raspberry Pi Pico • 4 x мъжки-мъжки джъмперни 
проводници 

• 1 x Пълноразмерна платка • 1 x HC-SR04 Ултразвуков 
сензор 

• 1 x Micro-USB кабел  

Схема на свързване 

 

- VCC (червен кабел) е свързан към 5V шина (+) 

- GND (черен кабел) е свързан към GND шина (-) 

- TRIG (оранжев кабел) е свързан към щифта GPIO2 

- ECHO (зеленият кабел) е свързан към щифта GPIO3 
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Код 

За да използваме ултразвуковия сензор HC-SR04, можем да 

разработим собствена програма или да използваме някоя от 

наличните библиотеки, например в Github. Ако решите да 

изтеглите библиотеката hcsr04.py, трябва да я запишете във 

вашия Pico под същото име. 

Код на MicroPython, използващ съществуваща библиотека: 

 

  

https://github.com/rsc1975/micropython-hcsr04/blob/master/hcsr04.py
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Код на MicroPython без съществуваща библиотека: 

 

Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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13. PIR сензор за движение 

Описание 

В този урок ще научите как да свържете и управлявате PIR 

сензора за движение. Отворете Thonny Python, след това 

отидете на File→ Save as..., изберете Raspberry Pi Pico и 

запишете файла под името motion.py. След това е време 

да свържете електрониката и да напишете програмата си. 

Моля, следвайте инструкциите по-долу. 

Необходими материали 

• 1 x Raspberry Pi Pico • 3 x мъжки-женски свързващи 
проводници 

• 1 x Пълноразмерна платка • 1 x PIR сензор за движение 

• 1 x Micro-USB кабел  

Схема на свързване 

 

- VCC (червен кабел) е свързан към 5V шина (+) 

- GND (черен кабел) е свързан към GND шина (-) 

- OUT (оранжев кабел) е свързан към щифт GPIO5 
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Код 

Код на MicroPython за урока: 

 

Образци на изображения  

Изображение на начина, по който изглежда урокът при 

използване на предоставения хардуер: 
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14. Сензор за пламък 

 

Описание 

В този урок ще научите как да свържете и управлявате 

сензора за пламък KY-026. Отворете Thonny Python, след 

това отидете на File  Save as..., изберете Raspberry Pi Pico 

и запазете файла си под името flame.py. След това е време 

да свържете електрониката и да напишете програмата си. 

Моля, следвайте инструкциите по-долу. 

Необходими материали 

- 1 x Raspberry Pi Pico - 3 x джъмпери от мъжки до мъжки тип 

- 1 x Пълноразмерна платка за хляб - 1 x Датчик за пламък 

KY-026 

- 1 x Micro-USB кабел  

Схема на свързване 
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- VCC (червен кабел) е свързан към 5V шина (+) 

- GND (черен кабел) е свързан към шината GND (-) 

- DO (зелен кабел) е свързан към щифта GPIO5 

 

Код 

Код на MicroPython за урока: 

  

Примерна снимка  
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Изображение на начина, по който изглежда урокът, като се 

използва предоставеният хардуер: 

 

 

   

16.  Сензор за откриване на газ MQ-135 

Описание 

В този урок ще научите как да свържете и управлявате 

сензора за откриване на газ MQ-135. Отворете Thonny 

Python, след което отидете на File  Save as..., изберете 

Raspberry Pi Pico и запишете файла си под името gas.py. 

След това е време да свържете електрониката и да 

напишете програмата си. Моля, следвайте инструкциите по-

долу. 

 

Необходими материали 

- 1 x Raspberry Pi Pico - 3 x джъмперни проводници от мъжки 

до мъжки тип 

- 1 x Пълноразмерна платка за хляб - 1 x MQ-135 за 

откриване на газ 

- 1 x Micro-USB кабел  
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Схема на свързване 

 

 

- VCC (червеният кабел) е свързан към шината 3v3 (+) 

- GND (черен кабел) е свързан към шината GND (-) 

- DO/OUT (жълт кабел) е свързан към щифта GPIO5 

  

Код 

Код на MicroPython за урока: 

  

Примерна картина  



 
2021-1-DE02-KA220-ADU-000033587 

 

 
 

87 w: sh4seniors.erasmusplus.website 

e: info@sh4seniors.erasmusplus.website 

Изображение на начина, по който изглежда урокът, като се 

използва предоставеният хардуер: 

 

 

 

 

ПРИЛОЖЕНИЕ: Таблица за обобщение 
на MicroPython 

 

Цифров изход 

Извикване на 
класа Pin 

from machine import Pin  

Иницииране на 
обекта за цифров 
изход 

led = Pin(pin_value, 

Pin.OUT) 

pin_value from 0 to 

40 

Отворен цифров 
изход (изход 3,3 
V) 

led.value(1) ON 

Затваряне на 
цифров изход 
(изход 0 V) 

led.value(0) OFF 
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Цифров вход 

Извикване на 
класа Pin 

from machine import Pin  

Иницииране на 
обекта за цифров 
изход 

 

button = Pin(pin_value, 

Pin.IN) 

pin_value от 0 до 40 

button = Pin(pin_value), 

Pin.IN, Pin.PULL_UP) 

Активиране на 
съпротивлението 
PULL UP 

button = Pin(pin_value), 

Pin.IN, Pin.PULL_DOWN) 

Активиране на 
съпротивлението 
PULL DOWN 

Четене на входа 

value = button.value(1) 

Върнатата стойност 
може да бъде 0, ако 
изводът е с 
напрежение 0 V, или 
1, ако изводът е с 
напрежение 3,3 V 

 

Аналогов изход (широчинно-импулсна модулация - ШИМ) 

Извикване на 
класа PWM 

from machine import PWM  

Иницииране на 
аналоговия изход 

led = 

PWM(Pin(pin_value), 

frequency) 

pin_value от 0 до 40 

Отчитане на 
входа 

led.duty(duty_cycle) 
честота в HZ, от 0 до 
78125 

 

Аналогов вход 

Извикване на 
класа ADC 

from machine import ADC  

Иницииране на 
аналоговия вход pot = ADC(Pin(pin_value)) 

pin_value can be GPIO26, 

GPIO27 and GPIO28 
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Деклариране на 
напрежението, 
при което входът 
ще дава 
максималната си 
стойност (в 
ESP32 
обикновено 3,3 
V) 

pot.atten(ADC.ATTN_11DB) 

ADC.ATTN_0DB: full range 
voltage: 1.2 V 

ADC.ATTN_2_5DB: full range 
voltage: 1.5 V 

ADC.ATTN_6DB: full range 
voltage: 2.0 V 

ADC.ATTN_11DB: full range 
voltage: 3.3 V 

Деклариране на 
обхвата на 
входната 
стойност (по 
подразбиране 
12bit) 

pot.width(ADC.WIDTH_10BIT) 

ADC.WIDTH_9BIT: range 0 to 511 

ADC.WIDTH_10BIT: range 0 to 
1023 

ADC.WIDTH_11BIT: range 0 to 
2047 

ADC.WIDTH_12BIT: range 0 to 
4095 

Четене на входа 
value = pot.readl() 

value is an integer from 0 to the 

maximum of the range specified by 
the ADC.WIDTH_#BIT statement 
(see previous) 

 

Библиотеката на времето 

Извикване на 
класа Sleep 

from time import sleep  

Използване на 
функцията sleep 

sleep(sec) 
sec is the number of seconds for 

which the program will be delayed 

Извикване на 
класа time 

import time  

Използване на 
функцията time current_time = time() 

The current_time variable will 

take a numeric value, equal to the 
number of seconds since the last 
reset on the board. 

 

 

Структура на изявлението If 

if <expr1>:  

     <statement1>  

elif <expr2>:  

     <statement2>  

<expr#>: условието за контрол, което трябва да връща True или False 

<statement#>: set of commands to be executed when the adjacent 
condition is satisfied 
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elif <expr3>:  

     <statement3>  

     (...)  

else:  

     <statementn>  

 

<expr#> (e.g. the set <statement2> is executed when <expr2> is satisfied) 

 

<statementn>: set of instructions executed when none of the <expr#> 
conditions are satisfied 

 

 

Структура на цикъла While 

while <expr>:  

   <statement(s)>  

<expr>: the control condition that must return True or False 

<statement#>: set of commands to be executed as long as <expr> condition 
is satisfied 

 

Структура на цикъла For 

for <var> in <iterable>: 

     <statement(s)> 

<iterable>: a collection of objects, 
for example a list containing 
numbers, alphanumerics, etc. 

 

<var>: a variable to which the value 
of the next item in the collection 
<iterable> is assigned. 

 

<stametement(s)>: a set of 
instructions executed at each 
iteration 

for <var> in range(<start>, <end>, <step>): 

     <statement(s)> 

range(<start>, <end>, <step>): 
function that returns a sequence of 
numbers from <start> to <end>-1, 
with a <step> difference between 
two consecutive numbers ( <start> 
and <step> parameters are 
optional). 

 

<var>: variable to which the value 
of the next element of the sequence 
produced by range is assigned. 

 

<statement(s)>: a set of 
instructions executed in each 
iteration 
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Различни 

DHT11 

import dht 
Импортиране на 
библиотеката DHT 

sensor = dht.DHT11(Pin(pin_number)) 

Иницииране на 
променливата на 
сензора с неговия 
асоцииран 
pin_number. 

sensor.measure() 

Актуализиране на 
стойностите на 
сензора 

temp = sensor.temperature() 

Запазване на 
текущата стойност на 
температурата 

hum = sensor.humidity() 

Запазване на 
текущата стойност на 
влажността 

OLED 
DISPLAY 

from machine import I2C 
Импортиране на 
библиотеката I2C 

import ssd1306 

Импортиране на 
библиотеката 
ssd1306 

i2c = I2C(-1, scl=Pin(1), sda=Pin(0)) 

Иницииране на 
променливата i2c на 
изводите SCL и SDA 
на Pico 

oled_width = 128 

oled_height = 64 

oled = ssd1306.SSD1306_I2C(oled_width, 

oled_height, i2c) 

Иницииране на 
екрана 
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oled.text('Hello, World 1!', 0, 0) 

oled.text('Hello, World 2!', 0, 10) 

oled.text('Hello, World 3!', 0, 20) 

Съхраняване на 
съобщения в буфера 
на екрана 

oled.show() 

Показване на 
съобщенията 
(необходимо за 
показване на 
съобщенията, 
съхранени в буфера 
на екрана) 

display.pixel(3, 4, 1) 

Задаване на пиксела, 
разположен на 
позиция (x,y) на 
екрана, с x=3 и y=4, в 
състояние 1 (т.е. 
показване) 
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Raspberry Pi Pico Pinout 
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